Windows 2000
Tips And Tricks
A

Windows 2000 boasts myriad
secrets that, once revealed,
can help administrators and
users take better control of
their working environment.
We look at some of the most
effective tips and tricks.

rguably, Windows 2000 is easier to use than any previous member of the
Windows family. That will change as users grow accustomed to Windows
XP, but until then Windows 2000 will do just fine and there’s no need to rush
into unnecessary upgrades.

By Dave Cook
IT Journalist

Folder Shortcuts

When users first launch Windows 2000, what they see is a desktop that has been
configured using defaults based on years of Microsoft usability studies. Unfortunately there is no such thing as an average user - or administrator, for that matter.
So perhaps it is just as well that Windows 2000 can be altered in numerous ways to
suit the habits of everyone as they go about their work. Likewise, there are countless
tips and tricks that can be applied, allowing administrators and users to better
control their working environment.

Folder shortcuts in Windows 2000 are more useful than their traditional counterparts, as they allow administrators to make any folder or disk drive on the user’s
machine act as if it were another folder. This is because Windows 2000 folder
shortcuts integrate the target into the shell namespace to present users with a direct
hierarchy. To create a folder shortcut, drag and drop a folder or disk drive icon onto
the Start menu, click the Start menu, and then select the folder or drive. The target
of the folder or drive shortcut is now grafted into the shell namespace. The result is
less user confusion, with the Up button pointing the way back to the folder that
contained the folder shortcut.
Using folder shortcuts on a network can be particularly productive. For example,
one way of exploiting a folder shortcut is to install a network share onto the Start
menu, and then target the share under the control of an administrator. To do so, click
Properties on the shortcut, and then from the Shortcut tab, enable the Run As Other
User option. When the shortcut is clicked, complete the relevant user name (Administrator) and password details. The administrator can then update the files on that
share, with the changes automatically reflected on the Start menu. Obviously, if the
user is someone other than the administrator then he or she must have the necessary
permissions to access the share.
Another way in which administrators can make use of Windows 2000 shortcuts is
to drag the My Computer icon onto the Start button. Not only does this create a
handy shortcut to My Computer, much as it does in Windows 95 or Windows 98,
but this shortcut is expandable, with each drive icon taking on its own menu entry.
Select one of the drives and it will expand to reveal the files or folders it contains.
Select one of the folders and it too will expand (Figure 1). The result is that everything
on the computer is now accessible from the Start Menu.
One so-called shortcut that Microsoft has put in place but which is proving to be not
such a good idea, concerns Windows Explorer. By default, Explorer is set to show
the My Documents folder on launch. Microsoft based this on the assumption that
most users work with documents more than with any other type of files. Unfortunately there are many advanced users out there who find the default view of the My
Documents folder to be a hindrance rather than aid to productivity. For these users,
setting up Explorer to open in a different directory should make file management
less of a chore.
To configure Explorer to show, for example, the main drive with the folders bar at
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launch, right-click on the Windows Explorer shortcut and select Properties. This
opens the Explorer Properties windows. From the Shortcut tab, go to the Target box,
and after EXPLORER.EXE, add a space and then add /E to the target path. Click OK
to apply the change. When launched, Explorer will now default to the contents of
the main directory of the Windows 2000 drive, with the folders bar visible on the
left. To view the main drive without folder bars, add /N to the target path instead
of /E. Alternatively, to view the contents of My Computer with a drive selected and
the folders bar showing, in the Target box, add /SELECT,/E,DRIVE:\ where
“DRIVE” is the preferred drive letter.

Time Savers
Here’s a quick way to add a submenu to the Start menu for a group of users. Begin
by logging on as the administrator. Right-click Start, and then click Open All Users.
Double-click the folder in which the submenu is to be added (usually the Programs
folder), and on the File menu, point to New, and then click Folder. Type a name for
the new submenu and then hit Enter. Alternatively, click an empty space on the
desktop to launch the context menu. This allows administrators to customise the
folder, or to gain access to the folder’s Properties settings. Having created the
submenu, users will be able to see it next time they log on.
Support staff who are constantly swapping and replacing the computer’s internal
hardware will love the idea of a desktop shortcut to Device Manager. After all, a
desktop shortcut saves several steps over the traditional route through Control
Panel. To create a shortcut to Device Manager, right-click anywhere on the desktop,
point to New on the context menu, and then click Shortcut. In the Create Shortcut
wizard, type C:\WINNT\SYSTEM32\MMC.EXE C:\WINNT\SYSTEM32\DEVMGMT.MSC in the location of the item box (assuming C:\WINNT is the default
system directory). Click Next, enter a name for the shortcut, and then click Finish to
create a desktop shortcut to Device Manager.
Virtually the same trick can be applied to creating a desktop shortcut to the
Computer Management tool. Computer Management is a utility that includes
Device Manager, as well as Event Viewer, System Information, Performance Logs

“Support staff who are
constantly swapping and
replacing the computer’s
internal hardware will
love the idea of a desktop
shortcut to Device
Manager.”
Figure 1 - Adding a My Computer shortcut onto the Start button.
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and Alerts, along with other useful management tools. To create a desktop shortcut
to the Computer Management utility, in the Create Shortcut wizard simply replace
DEVMGMT.MSC with COMPMGMT.MSC. Click Next, enter a name for the shortcut, and then click Finish.

Name Completion
The next time-saving tip applies to anyone who frequently has to navigate through
the directory structure and file lists using the command prompt. Navigation can be
speeded up considerably by enabling the Windows 2000 File and Directory Name
Completion feature. File and Directory Name Completion is invoked when users
type either of the two control characters at the command prompt. The two control
characters are Ctrl-D for directory names and Ctrl-F for filenames.
Thus, users who wish to view all of the directory names in the current path would
type CD, and then press Ctrl-D. While users who want to view files beginning with
specific characters would typically type the first few characters of a command
executable then press Ctrl-F. Users who need to move backwards through a list, for
example, would press and hold the Shift key, and then press Ctrl.
When enabling File and Directory Name Completion, users have two choices. To

“Navigation can be
speeded up considerably
by enabling the
Windows 2000 File
and Directory Name
Completion feature.”
Figure 2 - Adjusting mouse settings from Tweak UI.
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enable the feature for a single command prompt session, click Start, Run, and in the
Open box, type CMD /F:ON, and click OK. Alternatively, to enable the feature for
a command prompt session that is launched from a shortcut, click Start, point to
Programs, Accessories, and right-click Command Prompt. Under the Shortcut tab
in the Target box, type %SYSTEMROOT%\SYSTEM32\CMD.EXE /F:ON.

Taking Control
The Control Panel looks like a regular folder and the icons it contains look like
ordinary icons. Appearances, however, can be deceptive. The Control Panel is really
a Windows shell that uses a special type of program. These programs carry the .CPL
extension. They appear in the Control Panel as applets and typically allow users to
make system changes without having to directly edit the Windows Registry.
That said, one of Microsoft’s most useful configuration tools, Tweak UI, which
allows administrators to fine-tune the Windows users interface, cannot be found in
the Control Panel by default. To obtain and run the latest copy of Tweak UI, you
need to visit http://www.microsoft.com and download TWEAKUI.EXE. Be
warned, though, that the numerous tools contained within Tweak UI are not
supported by Microsoft.
With Tweak UI installed, administrators gain a number of useful power tools, or
PowerToys as they are sometimes called. For example, the Repair tool can help
administrators rebuild desktop icons, repair a corrupt font folder, repair the Registry
editor if, say, it is no longer showing all of its columns, or repair the Internet Explorer
cache folder. Clicking the Control Panel tab from Tweak UI will display a list of
applets available from the Control Panel shell. Clearing the check box next to the
name of an applet will prevent it from being displayed in the Control Panel.
Alternatively, selecting the check box enables the applet to be once again displayed
in the Control Panel.
Tweak UI includes two mouse sensitivity adjustment settings: Double-click and
Drag (Figure 2). The Double-click setting specifies how close (measured in milliseconds) any two mouse clicks must be before they are considered a double-click action.
While the second setting, Drag, specifies the distance the mouse pointer must be
moved before it can be considered a drag action. Usefully, a Test Icon area is
provided so that administrators can test the effects of any changes before letting
them loose on unsuspecting users.

“The Repair tool can
help administrators
rebuild desktop icons,
repair a corrupt font
folder, repair the
Registry editor if, say,
it is no longer showing
all of its columns, or
repair the Internet
Explorer cache folder.”
Figure 3 - The System Information tool is useful for finding problems.
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Among a host of other useful tools, Tweak UI also includes a Paranoia setting for
those of a distrustful nature. For example, administrators can choose to clear the
Documents history at logon, clear the Find Files history at logon, clear the Last User
display at logon, and clear the Network Connection history at logon. The Windows
2000 feature to automatically play audio and data CDs can also be disabled from
here. In addition, for reasons of security, administrators can elect to hide certain
drive icons from My Computer on a per-user basis. To do so, launch Tweak UI, select
the My Computer tab, and deselect the check mark next to the drive to be hidden.
Click OK, and the drive will “disappear” from My Computer.
Some users complain that anyone with access to their computer only needs to click
Start and then Documents to see a history list of the most recently opened documents. This history list is actually stored in the Registry. While it is possible to delete
the items from the list using a Registry editor, Windows 2000 provides a much easier
way to delete the list. Right-click the Taskbar and select Properties. In the Taskbar
And Start Menu properties window, click the Advanced tab and then click the Clear
button. When the user next selects Start, Documents, the list will be empty - but only
until the user opens another document.

Troubleshooting
Windows 2000 includes several utilities to help administrators repair a system that
will not start or will not load. But what if problems occur after the machine has
booted? The MSINFO tool allows administrators to view troublesome areas once
the computer is up and running. MSINFO is not much use for computers that will
not boot, but it is excellent at helping to resolve problems related to driver signings
and application software issues.
Once launched (Figure 3), MSINFO collects and displays the system configuration
details appertaining to the hardware, system components, and software environment of the machine involved. For example, MSINFO can quickly find the required
data to resolve problems with regard to the following categories:

System Summary
This displays basic information about the system such as the version number of the
operating system, the installation folder of Windows 2000, the NetBIOS computer
name, time zone information, as well as information about the amount of installed
physical memory and virtual memory.

“MSINFO collects and
displays the system
configuration details
appertaining to the
hardware, system
components, and
software environment of
the machine involved.”
Figure 4 - Active Directory deployment is now easier thanks to the Sizer tool.
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Hardware Resources
This reveals hardware resource settings such as direct memory access (DMA),
interrupt requests (IRQs), I/O addresses, and memory addresses.

Components
This section displays information about the Windows 2000 configuration. It determines the status of peripheral devices, ports, and USB connections.

Software Environment
This tab reveals a snapshot of drivers, environment variables, tasks and services
loaded into memory. Administrators can use this information to check whether a
process is still running, or to check version information.

Internet Explorer
The IE tab shows a list of configuration settings related to Internet Explorer. This
includes the install location, cipher strength, build number, a list of associated files
and version numbers, plus settings for connectivity, file caching, and security zones.

Applications
Finally, this tab displays a list of installed Microsoft applications, including Microsoft Office 2000 and later programs that support System Information.
Note that the Tools menu in MSINFO also provides links to several troubleshooting
utilities. These include Disk Cleanup, Dr. Watson for Windows 2000, DirectX
Diagnostic Tool, Hardware Wizard, Network and Dial-up Connections, Backup,
File Signature Verification Utility, Update Wizard Uninstall, and the Windows
Report Tool.
In Windows 2000, MSINFO can be accessed in a number of ways. The simple route
is to select Start, Programs, Accessories, System Tools, and then click System
Information. Alternatively, right click the My Computer icon on the desktop and
select Manage to launch MSINFO as part of the Microsoft Management Console
(MMC).
Usefully, administrators can print or save the machine’s system information to a text
file - stored in the My Documents folder by default - before sending the information
to support. Be warned, though, a full system information report printout can total
more than 80 pages, depending on the hardware and software installed.

“Hackers need only two
things to gain access to
a system’s resources: a
username and a
password. Unfortunately, Windows 2000
by default actually
provides the budding
hacker one of those
requirements for free.”
Figure 5 - Preventing last username details at logon.
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It’s well worth creating a full report for each machine under your control and filing
away these reports in a central location on a regular basis - say every six to 12 months.
These will come in useful when troubleshooting certain problems.

The Registry
Hackers need only two things to gain access to a system’s resources: a username and
a password. Unfortunately, Windows 2000 by default actually provides the budding
hacker one of those requirements for free. Without the assistance of Tweak UI, to
prevent a machine displaying the last username to have logged on involves opening
and making changes to the Registry. Windows 2000 provides two Registry editors:
REGEDIT.EXE and the 32-bit version, REGEDIT32.EXE.
Within the registry editor select the HKEY_LOCAL_MACHINE hive and then
double-click Software, Microsoft, Windows, CurrentVersion, Policies, and System.
Then in the right pane of the Registry, double-click the DontDisplayLastUserName
entry to open the DWORD editor. In the Data box, type 1 as the value (Figure 5),
and click OK. This prevents the system from displaying the last username to have
logged on at that machine. It will mean users having to enter their usernames each
time they log on, as well as their password, but that is a task even the most forgetful
of users should be capable of performing. It also removes a significant security risk,
especially as many users tend to use their username (or an easily guessable derivative thereof) as a password.

Get Resourceful
Shoddy workmen have a habit of blaming their tools - or even the fact that they
haven’t any. In Windows 2000, however, administrators have no such excuse
thanks to Microsoft making available a number of Resource Kit tools and user
guides. In the main, Resource Kit utilities are designed to help administrators
streamline important tasks such as managing Active Directory, administering
security features, automating application deployment, and so forth.
Resource Kit tools are usually fairly easy to come by. One method of obtaining
the tools is to download them from Microsoft’s Web site. Alternatively, nearly
300 tools are included on the Windows 2000 Server Resource Kit companion
CD, while the Windows 2000 CD-ROM contains approximately 50 Resource
Kit tools.
Of course, the value of any Resource Kit tool will depend on the task in hand.
However, any utility that aids deployment of Active Directory has to be worth
investigating. While the introduction of Active Directory should in the long run
make Windows 2000 administration easier within your organisation, deploying
it is a major undertaking and many have not yet taken the giant leap that it
requires.
One useful tool is ADSIZER.EXE. Based on user input and internal formulas,
the Sizer tool (Figure 4) provides estimates involving the following tasks:

“To stop a stubborn
program from
launching at startup,
open REGEDT32.EXE
and select the
HKEY_LOCAL_
MACHINE hive.”
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Number of domain controllers per domain per site.
Domain database size.
Number of global catalogue servers per domain per site.
Global catalogue database size.
Number (and type) of CPUs per machine.
Amount of memory required .
Number of disks required for Active Directory data storage.
Bandwidth required for intersite replication.

Sizer is available for download from http://www.microsoft.com/windows2000/techinfo/reskit/tools/new/adsizer-o.asp. The download tool is a
self-extracting file and includes the files required to run Sizer, a documentation
file, and a readme file containing information about the various Windows 2000
Resource Kit tools.
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Further Information
Whether you’re still rolling out Windows 2000 or you simply need to tweak
existing installations, the planning and deployment guides at http://www.microsoft.com/windows2000/techinfo/planning will be of use.
At
http://www.microsoft.com/windows2000/techinfo/planning/walkthroughs you’ll find step-by-step guides to Windows 2000 features and services.
You’ll find TweakUI at http://www.microsoft.com/ntworkstation/downloads/PowerToys/Networking/NTTweakUI.asp.
A list of Resource Kit tools available for download can be found at
http://www.microsoft.com/windows2000/techinfo/reskit/tools/.
The ADSIZER tool is at http://www.microsoft.com/windows2000/techinfo/reskit/tools/new/adsizer-o.asp.
The Application Security tool which restricts file execution to unauthorized
users is downloadable from http://www.microsoft.com/windows2000/techinfo/reskit/tools/hotfixes/appsec-o.asp.

IE Password Logs
Still on the subject of security, Internet Explorer has the ability to remember the
passwords when users log onto certain Web sites. To disable this feature, called
Password Caching, open the Registry editor and open the HKEY_CURRENT_USER
hive. Next, drill down to the Internet Settings key via Software, Microsoft, Windows,
CurrentVersion, and Internet Settings. From the Edit menu, select Add Value, and
give the new entry the name DisablePasswordCaching. In the Data Type box choose
REG_DWORD, and click OK. This opens the DWORD editor. In the Data box, type
1 as the value, and click OK to disable password caching in Internet Explorer.

Startup Programs
One final tip involves stopping a stubborn program from launching at startup. Some
program installation routines bypass the Startup menu, directly adding a program’s
link to the Registry instead. This is partly to make sure users gain quick access to
the programs. Unfortunately it also ensures users cannot easily remove the program’s link. Loading programs in this way can sap essential resources and should
be avoided.
Thankfully, administrators can dip into the Registry to remove these programs, so
that they are unable to load and remain in the background (Tray) after boot up. To
stop a stubborn program from launching at startup, open REGEDT32.EXE and select
the HKEY_LOCAL_MACHINE hive. Drill down to Software, Microsoft, Windows,
CurrentVersion, and Run. In the right pane, select the program to be removed, click
the Edit menu at the top of the screen, and click Delete (Figure 6). A warning message
will appear. Click OK, and Windows 2000 will no longer be able to run the program
at startup. Close the Registry editor and restart Windows 2000 for the changes to
take effect.

PCNA
Figure 6 - Halting stubborn
programs from launching at startup.
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New Reviews from Tech Support Alert
Anti-Trojan Software Reviews
A detailed review of six of the best anti trojan software programs. Two products
were impressive with a clear gap between these and other contenders in their
ability to detect and remove dangerous modern trojans.
Inkjet Printer Cartridge Suppliers
Everyone gets inundated by hundreds of ads for inkjet printer cartridges, all
claiming to be the cheapest or best. But which vendor do you believe? Our
editors decided to put them to the test by anonymously buying printer cartridges
and testing them in our office inkjet printers. Many suppliers disappointed but we
came up with several web sites that offer good quality cheap inkjet cartridges
with impressive customer service.
Windows Backup Software
In this review we looked at 18 different backup software products for home or
SOHO use. In the end we could only recommend six though only two were good
enough to get our “Editor’s Choice” award
The 46 Best Freeware Programs
There are many free utilities that perform as well or better than expensive
commercial products. Our Editor Ian Richards picks out his selection of the very
best freeware programs and he comes up with some real gems.
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